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What's New?

In the user manual, the icon has been added on the left margin to highlight
information on new and updated features.

No section has been updated in the Xedio Browsemanual from Xedio Suite 4.50
(compared to Xedio Suite 4.40).
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1. Introduction

1.1. Product Description
The Xedio Browse application allows a user to browse and preview media within a Xedio
Suite environment.

The supportedmedia can be either data already imported into the Xedio Suite or files
currently being ingested into the system as a "live feed".

With Xedio Browse, themedia can be segmented into several "virtual media". This can be
useful, for example, to break down a single news feed includingmultiple stories into
several sections each containing an individual story. In the case of a football match,
virtual media can be produced with the goals or highlights directly from the incoming feed.

Multiple virtual media can be created from the same source.

The virtual media does not require any splitting of the original file as it is only made of
markers placed on the original media file. There is no new media file created.

Specific metadata can be assigned to each virtual media.

1.2. Opening Xedio Browse
To start the Xedio Browse application, select the application from Start > Programs >
EVS Broadcast Equipment or click on theXedio Browse shortcut icon on the desktop.

The Xedio workstationmay be integrated into an Active Directory domain. In this case,
Xedio Browse will automatically open without requesting additional access codes when
the user starts it.

The user group the user belongs to in theWindows domainmust be linked to a user role in
XedioManager. This determines the set of user rights and user settings the user will have
in the application. In case a user belongs to several Windows groups, the system retrieve
them in alphabetical order and checks whether the first groupmatches a user role. The
use of Windows authenticationmust have been enabled in XedioManager. See the Xedio
Manager user manual for more information.

In case the auto-log off mode is activated and theWindows authentication by Active
Directory mode is used, the auto-log off becomes an auto-quit function.

If the Xedio workstation is not integrated into an Active Directory domain, a login screen
will display, where users have to enter their own Xedio username and password.
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1.3. Overview of the Xedio Browse
Window

Illustration

The Xedio Browse window contains the areas highlighted on the screenshot below:

Note
The color of some user interface elements may vary with the Xedio skin
installed.

2 1. Introduction
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Area Description

The table below describes the various parts of the Xedio Browse window:

Part Name Description

1. Player
Pane

This is used to play media loaded from the Tabs pane or virtual media
loaded from the Virtual Media pane. The Player pane is used together
with the Tabs pane to create virtual media.
Everything that is outside the video content has the skin color. Video
such as letterboxed or pillarboxed video will show black bars as these
mattes are part of the video signal

2. Tabs
Pane

The Tabs pane contains two tabs.
TheMedia tab displays the list of media available in the Xedio database.
This is used to select themedia to load in the Player pane. It has the
same powerful filtering and search attributes as other parts of the Xedio
Suite of applications allowing to easily find the requiredmaterial.
The Virtual Media Properties tab displays the properties andmetadata of
themedia, or virtual media, loaded on the Player pane.
This is also used to create virtual media within the original file and assign
it specific metadata.

3. Virtual
Media
Pane

The Virtual Media pane gives the list of the virtual media created from the
original file selected in theMedia tab.

Adaptable Display

The layout of the Xedio Browse can be adapted to users' needs.

The different panes can be hidden either by clicking the cross at the top right corner of
each pane or by selecting one of the options of the View menu: Player, List area (Virtual
Media pane),Work area (Tabs pane). The hidden pane(s) can then be displayed by
selecting the corresponding option of the View menu. Seven layouts are available:

• Player + Tabs pane + Virtual Media pane

• Player + Tabs pane

• Player + Virtual Media pane

• Tabs pane + Virtual Media pane

• Player only

• Tabs pane only

• Virtual Media pane only

The different panes can be resized.
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1.4. Process Overview
The use of Xedio Browse can be summarized as follows:

1. Select a media from the Media Tab of the Tabs Pane.

See section "TheMedia Tab" on page 5.

2. Load it on the Player Pane.

See section "LoadingMedia on the PlayerWindow" on page 31.

3. Create a virtual media from the loaded media.

See section "Creating a Virtual Media" on page 19.

4. View the list of virtual media associated to a media.

See section "Virtual Media Pane" on page 33.

4 1. Introduction
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2. Tabs Pane

2.1. Introduction
The Tabs pane consists of two tabs: theMedia tab and the Virtual Media Properties tab.

• TheMedia tab is used to select themedia tomanage.

• The Virtual Media Properties tab can be used to create virtual media from an existing
media. The virtual media is only made of markers placed on the original media file.
There is no new media file created.

2.2. The Media Tab

2.2.1. Overview of the Media Tab

The upper part of theMedia tab gives access to the different filters which can be applied to
themedia list.
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At least two tabs exist on the left of theMedia tab.

• The Filter 0 tab: The element list displays the list of all media present in the database,
or it returns the result of a search applied to the list.

• The Today tab: the element list shown themedia with "creation date = today".

Additional tabs are displayed when the users have saved filters applied to the database.
for more details. Media items are displayed in columns.

2.2.2. Media List Area

Sorting the Elements in the Grid
You can change the sort order of elements in the grid by clicking the column header for the
parameter according to which you want to sort the elements.

The blue arrow indicates the sorting order. Clicking the column header again changes the
sorting order from ascending to descending or vice versa.

Organizing Columns

Resizing Columns
A column can be resized by using themouse pointer over columns intersection and
dragging it to the right or to the left.

Selecting Columns to Display
To select the columns to display in the grid, proceed as follows:

1. Right-click the column header area.

A menu is displayed.

2. Select Choose Displayed Columns.

The Select Visible Columns window opens and shows the list of columns in the
current order.

3. To select the column(s) you wish to add to the view, do one of the following:

◦ in the left pane, double-click the column(s) you wish to add to the view

◦ select them in the left pane and click theAdd button

4. To select the column(s) you wish to remove from the view, do one of the following:

◦ on the right pane, double-click the column(s) you wish to remove from the view

◦ select them on the right pane and click the left arrow

5. Click OK.

6 2. TabsPane
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Ordering Columns
To change the columns order, proceed in one of the following ways:

1. Select a column header

2. Drag it to the left or right to the required place.

A vertical line shows the place where the columnwill be dropped.

OR

1. Right-click a column header.

A menu is displayed.

2. Select Choose Displayed Columns.

The Select Visible Columns window opens and shows the list of columns in the
current order.

3. Select the column name(s) from the Selected pane.

4. Click the appropriate button:

◦ Up: moves the item(s) before the previous one

◦ Down: moves the item(s) after the next one

5. Click OK.

Element Contextual Menu
A contextual menu with the following options is available when you right-click an item in
the list.

Play
Loads themedia in the Player to allow the element to be browsed andmodified.

Render List
Opens the Render List window listing all types of rendering that have been done with the
media.

Archive History
Opens the Archive History window listing the archive and restore processes that were
achieved for the selectedmedia.

Change Properties
Opens theMedia Properties window which shows the properties for the selectedmedia. If
a default metadata profile has been defined for themedia, ametadata tab is displayed and
shows themediametadata.
See the XedioManager manual for more information on the selection of a profile.
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2.3. Searching for Elements in the List

2.3.1. Introduction
When the database contains large amounts of data, it may become difficult to find a
specific element. The Xedio Suite offers several ways to speed up your search:

• quick text search

• filters on parameters

By default, the columns that are taken into consideration for the Quick Text Search are the
ones currently visible in the grid.

If you wish to search in other columns, and view the string you are searching for in the
columns, you can:

• add other columns to the Elements grid view

• use Filters, as explained in section "Advanced Search" on page 10.

These search tools are explained in detail below.

An applied filter can be saved for later use. Such a saved filter can then be applied in one
click.

A search can also be facilitated by ordering the Elements grid.

8 2. TabsPane
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2.3.2. Quick Text Search

Purpose and Context of Use
TheQuick Text Search function is used to perform a search based on free text entered in
theQuick Text Search field. This field is available on the top of the Elements grid.

It allows searching for a string in the displayed columns.

Users can enter a search string in one of the following ways.

• They enter the search string in full in theQuick Text Search field.

TheQuick Text Search option obeys specific rules which can be accessed via the

Help button next to theQuick Text Search field.

See section "Quick Text Search Rules" on page 9 for more details on these rules.

• They click the arrow next to theQuick Text Search field, so the last 10 searches are
displayed, and they select one of them.

Quick Text Search Rules
The string that you enter in theQuick Text Search field is analyzed according to the

following set of rules, which can be accessed via theHelp button next to theQuick
Text Search field.

The free text search is not a case sensitive operation.

Search String Search Result

Yellow card Searches for the strings "yellow" and "card", even if in two different
fields (columns), for example "yellow" in Name and "card" in
Keywords.
For example a clip named "The Yellow Man" with keywords "Red
Card" will be found, since it has yellow and card in 2 different fields.

"Yellow card" Searches for strings containing "Yellow card".

Yellow | card Searches for "yellow" or "card", even if in two different fields
(columns), for example "yellow" in Name or "card" in Keywords.
Spaces around the | sign aremandatory.

yell* Searches for "yell" at the beginning of a string.

*low Searches for "low" at the end of a string.
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Search String Search Result

Ye*low Searches for strings with "ye" at the beginning and "low" at the end.

Ye*low 123 Searches for strings with "ye" at the beginning and "low" at the end
and which contains "123".

=card Searches for a string exactly equals to "card".
For example, if a field contains "yellow card", the =card condition
will not return any result.

=”yellow card” Searches for a string exactly equals to "yellow card".
The use of quotes is required due to the space between "yellow" and
"card".

How to Perform a Quick Text Search
To perform aQuick Text search, proceed as follows:

1. Display the columns you wish to perform a quick search on.

2. Type a search string in theQuick Text Search field, based onQuick Text search

rules available from theHelp button and detailed in section "Quick Text Search
Rules" on page 9.

3. Click theSearch button to apply the Quick Text Search.

Depending on whether theAutoRefresh Filtering setting is selected or not, youmay
not have to click theSearch button to apply the Quick Text Search. Refer to the tab
Software > Parameter Profiles > General > General in XedioManager.

The search result is displayed in the grid.

4. To clear the applied Quick Text Search, click the red button to the right of the
search field or select <empty> from theQuick Text Search drop-down list.

2.3.3. Advanced Search

Purpose and Context of Use
The Advanced Search functions are available for more detailed search operations. They
allow searches onmediametadata.

From the Today tab, the filter "creation date = today" is automatically applied.

The Advanced Search fields can be displayed on the top left part of the Elements grid.
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Advanced Search Fields Display

Displaying Advanced Search Fields

Show/Hide Filter Button

To display the Advanced Search fields, click theShow/Hide Filter button above the
grid.

The Advanced Search area is expanded as follows:

TheShow/Hide Filter button can be displayed with two different colors:

Button
Display Meaning

(gray)

TheShow/Hide Filter button is gray when all filter criteria are hidden.
Consequently, the filters are inactive.

(colored)

TheShow/Hide Filter button is colored when the Advanced Search area is
visible, even if no filtering criterion is applied.

Criteria Combination Field
The first field under theShow/Hide Filter button lists three options for the combination of
criteria to be taken into account during the filtering operation.

Option Meaning

ALL criteria
are met

All the criteria selected in the Filter fields displayed under theCriteria
Combination field must bemet.
Themedia displayed in the Elements grid fulfill all the selected filter
criteria.

ANY criteria
is met

At least one of the criteria selected in the Filter fields must bemet.
Themedia displayed in the Elements grid fulfill at least one of the
selected filter criteria.
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Option Meaning

NO criteria
is met

None of the criteria selected in the Filter fields displayed under the
Criteria Combination field must bemet.
Themedia displayed in the Elements grid fulfill none of the selected filter
criteria.

Search Parameters List
The second field gives access to the list of available advanced search parameters. Click
the arrow next to the field to display the list.

Users are then able to add as many search fields as needed and to enter search criteria for
each of them.

Advanced Search Fields
Once a search parameter has been selected, an entire line is displayed.

Interface
Element Description

1 Selected search parameter.

2 Various fields used to enter the filter criteria. See section "Advanced
Search Fields Types" on page 13.

Used to remove the corresponding filter line.

Used to add a new filter line.

Hiding Advanced Search Fields

To hide all the Advanced Search fields, click theShow/Hide Filter button again.
Consequently, all the applied filters are removed.

To remove an Advanced Search field from the Advanced Search area and thus clear the

corresponding applied filter, click the button next to the field.
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Advanced Search Fields Types
Depending on the selected search parameter, different types of advanced search fields
will be displayed and available to enter criteria.

Timecode or Duration Parameter
Such as TC IN, TC OUT, Duration…

1. Select a logical operator in the first field

2. Enter a timecode or duration value in the second field.

Timecode Range

1. Select an option from the first field

2. Enter a timecode value.

This will include, or exclude, media containing the specified timecode value.

Date
Such as Creation Date

Several Date Search filters exist.

1. Select a condition or a logical operator in the first field
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2. This will condition the next step:

◦ Search based on a specific date (e.g. with =…): a calendar will be displayed for
the selection of a date.

◦ Search based on an interval (e.g. with […] (between)…): two calendars are
displayed for the selection of two dates.

◦ Search based on a specific date calculated from the current date (e.g. with
tomorrow, last month,…): no other field appears.

Time
Such as Last Rendered Date Time

Several Date Search filters exist.

1. Select a condition or a logical operator in the first field
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2. This will condition the next step:

◦ Search based on a specific date and time (e.g. with =…): two additional fields will
be displayed, a calendar for the selection of a date and drop-down list for the
selection of time.

◦ Search based on a specific date and time calculated from the current date and
time (e.g. with next hour, last month,…): no other field appears.

Number
Such as DB Id

1. Select a logical operator in the first field

2. Enter a number in the second field.

Note
<>means "differs from".

Option List
Such as Video Standard

1. Select a logical operator in the first field

2. Click the button to display the list of options available for the selected filter
parameter.

Example for the Video Standard:

3. Select an option from the list.
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Boolean
Such as Published

• Select Yes or No from the single criteria field.

Free Text
Such as Label

1. Select a condition in the first field.

2. Enter free text in the second field.

How to Perform an Advanced Search
To enter search values in the Advanced Search fields, proceed as follows:

1. Choose the columns you wish to perform a search on.

2. Click theShow/Hide Filter button

The Advanced Search area is displayed:

3. Select a criteria combination from the list:

4. Select a search parameter from the list of parameters.

An entire line, corresponding to the selected filter parameter, is displayed:
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5. Enter filter criteria as explained in section "Advanced Search Fields Types" on page
13.

For free text fields, press ENTER to apply the filter.

Otherwise, the Elements grid is automatically filtered and refreshed.

6. If required, click the button to add another advanced search parameter.

2.3.4. Using Saved Filters

Introduction
Once you have defined filters and search terms, youmay want to save them for later use.
You will then be able to apply the same set of filters with a single click.

Saved filters appear as tabs.

At least two tabs exist on the left of the Elements grid.

• The Filter 0 tab: The Elements grid displays the list of all elements present in Xedio
Dispatcher, or it returns the result of a search applied to the list.

• The Today tab: the Elements grid shows the elements with "creation date = today".

Warning
Those filters can bemodified by the user, so the results could no longer reflect
the tab label.

Saved Filter Contextual Menu
Right-clicking in the Filter 0 tab displays a contextual menu with the following options:

Create New Filter
Allows to create a new filter tab through the Filter Edit Dialog wndow:

Save Filter As
Allows to create a new filter tab in which the current search filter will be saved.

Filter Properties
Allows to change the name and/or description of the selected filter tab.

Reset Filter
Removes all search criteria on the selected filter tab.

Delete Filter
Removes the filter tab.
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How to Save Filters
To save filters, proceed as follows:

1. Define the filter or filters combination you wish to save, as explained in section "How
to Perform an Advanced Search" on page 16.

2. Right-click the Filter 0 tab.

3. Select Save Filter As from the contextual menu.

The Filter Edit Dialog box opens.

4. Enter a label for the tab you are going to create and, if required, enter a description.

5. Click OK.

The new filter tab is displayed on the left of the list.

How to Apply a Saved Filter
To apply a saved filter, simply click the corresponding tab.

2.4. The Virtual Media Properties Tab

2.4.1. Overview of the Virtual Media Properties Tab
The Virtual Media Properties tab can only be selected when amedia is loaded on the
Player pane.

The tab display differs according to the type of media loaded.

If themedia is a complete or currently ingesting file ("Media"), the tab will display the
properties of the loadedmedia and provides buttons to create virtual media from this
media file:

18 2. TabsPane

EVSBroadcast Equipment SA Issue 4.50.A - August 2014



If the loadedmedia is a virtual media file the tab will display its properties ready for update:

2.4.2. Creating a Virtual Media
To create a virtual media, proceed as follows:

1. Load the requiredmedia from theMedia tab to the Player pane.

2. Browse in themedia until you select theMark IN point and click the

button or press the key.

TheMark In Timecode field is filled and appears in green. The thumbnail IN is
displayed.

A default label is automatically assigned into the Label field. This can be accepted or
changed at this stage or later if necessary.
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3. Browse in themedia until you select theMark OUT point and click the

button or press the key.

TheMark Out Timecode and theDuration fields are filled and theMark Out
Timecode field appears in red. The thumbnail OUT is displayed:

4. The other fields from theGeneral tab display the properties from the original media.
You can accept or modify these values and you can enter a description.

5. Select thePublished option if you want the other users to be able to see the virtual
media.

6. In theMetadata tab, you can click in the cell next to "Metadata Profile" and select a
metadata profile; then, you can enter specific metadata values in the fields.

7. Click theSave button to save the virtual media.

The Virtual Media is immediately displayed in the Virtual Media pane.

Note
If the virtual media has been recorded as published, it will be locked and not
available for later update. You will get the following warningmessage:

Note
There is an administrator setting which prevents creation of virtual media that
overlap each other. If this setting is active a dialogue box will open to alert the
user that the virtual media overlap:
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2.4.3. Auto Clipping Modes
To go faster when creating the Virtual Media, it is possible to avoid the action of clicking
theSave button.

From the XedioBrowsemenu of themain toolbar, select Auto Clipping Modes and then
Auto Save.

Then, a virtual media will be created as soon as you have defined both theMark IN and
theMark OUT points.
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3. Player

3.1. Overview of the Player Pane
The Player pane provides a video display, amedia bar and a jog bar to navigate within the
element, video and audio selection andmonitoring buttons, transport buttons and
timecode fields. It slightly differs according to the element loaded.

When amedia is loaded from the Tabs pane, it looks as follows:

When a virtual media is loaded from the Virtual Media pane, the Player pane looks like the
following screenshot:

22 3. Player
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3.2. Video Display Options
A contextual menu is available when right-clicking the Video Display area. This gives
display options for the video.

Show Timecode
This option offers various options to display timecode on the Player window.
• none: does not display timecode.
• Start TC: shows a counter starting with 0 at the first frame of themedia.
• Intra TC: shows the original timecode of themedia.
• Both: displays both the counter and the original timecode.

Aspect Ratio
This option offers a choice of aspect ratios for the display: Auto, 4:3 or 16:9.

Show Safe Areas
This option displays a safe area cage on the window to determine which areas of the
picture will be seen. This allows to check the size of graphics within themedia for safe
display.

Deinterlacer
This option is used to de-interlace video. A submenu provides the following options:
• Mix top/bottom: displays 25 full pictures per second, eachmade by mixing the top

field and the bottom field and repeating eachmixed line.
• Top: displays 25 full pictures per second, eachmade by duplicating each line of the

top field.
• Bottom: displays 25 full pictures per second, eachmade by duplicating each line of

the bottom field.
• None: displays 25 pictures per second, eachmade from both interlaced fields.

3.3. Player Controls

3.3.1. Player Transport Controls
Please refer to the XedioManager user manual for a comprehensive list of the shortcuts.

Controls Common to Media Player and Virtual Media Player

Operation User Interface Button Shortcut

Play and Pause

↔

Play Near Live a media while
ingesting (digitizing) +
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Operation User Interface Button Shortcut

Go to Start of Media

Go to End of Media

Controls Specific to the Media Player

Operation User Interface Button Shortcut

Fast Forward
+

Fast Rewind
+

Goto Next Frame

Goto Previous Frame

Controls Specific to the Virtual Media Player

When a virtual media is loaded on the Player, the four lower transport buttons become trim
buttons for the IN andOUT points of the virtual media:

Note
If the loaded virtual media is declared as published or the original media is
declared as treated, you will not be able to use those four buttons.

Operation User Interface Button

Remove 1 frame from Mark IN point
(grey)

Add 1 frame to Mark IN point
(grey)

Remove 1 frame from Mark OUT point
(colored)

Add 1 frame to Mark OUT point
(colored)
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3.3.2. Timecode Value Fields

Three Timecode Value fields are displayed under the Transport buttons.

Area Description

1. Media Start Timecode (first recorded frame), even if a virtual media is loaded

2. Current Timecode position (nowline)

3. Media End Timecode (last recorded frame), even if a virtual media is loaded.

3.3.3. Video and Audio Monitoring Tools

Overview of the Video and Audio Tracks

The video and audio channels of a loaded source file are represented below the Video
DisplayPlayer in the form of Track Selection buttons.

Here is an example with 4 tracks of stereo channels:

The different types of audio tracks of a loadedmedia or clip are displayed as follows:

• Amono track is represented by

• A stereo track is represented by .

• A 5.1 track is represented by
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Note
If the loadedmedia/clip contains more than 8 audio tracks, only the first 8 tracks

are displayed under the Video Display. A first click on the button allows to
display the additional tracks.

Video and Audio Tracks Selection

When you create a virtual media, you need to select the video and the requested audio
channels.

Selection of the Video Channel

TheVideo button is clicked to select or remove the video. So the virtual mediamade
contains, or not, the video.

Selection of an Audio Channel

The left and the right loudspeaker buttons of an audio stereo track are used to
select or remove respectively the left or the right channel of the corresponding audio track:

Clicking the left audio button will remove the left audio component from the source so that
the virtual mediamade has no left audio channel. In this case, the right channel will be
output on the left and right channels.

Clicking both left and right audio buttons will also remove the right audio component so
that the virtual mediamade has no audio channel for this track.

A mono track is removed from the selection by clicking the loudspeaker button on the right
of the radio button:

A 5.1 audio track is removed from the selection by clicking the loudspeaker button on the
right of the radio button:
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The next table summarizes how the buttons look like depending on the selection:

Selected Removed

Video

Audio

Selection of the Track for Audio Monitoring

The radio buttons displayed between each pair of stereo channel buttons or next to a
mono or 5.1 audio channel button allow the selection of one audio track for monitoring:

Note
When you right-click on a 5.1 radio button, a popupmenu appears in which you
can select the 5.1 components that should bemonitored on the left and right
channels. You can choose between the following options: Mixed, L+R, Ls+Rs
or Center (output on L+R speakers).

Audiometers located on the right side of the Video Display represent the audio channels
of themonitored track.
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3.3.4. Media Bar and Jog Bar

Media Bars

Top Bar

The top bar represents themedia, or a portion of it, currently loaded on the Player.

Themedia bar display differs according to the loaded element.

Media

When amedia is loaded, only the nowline is displayed:

Virtual Media

When a virtual media is loaded, themark IN point, themark OUT point and the nowline are
displayed on this top bar.

Middle Bar

Themiddle bar is used to zoom into the loaded element.

Its dark gray zone shows the section of themedia, out of the wholemedia, visible in the
top bar and the relative position of the visible section in the wholemedia.

• When amedia or an edit has just been loaded, the top bar represents the wholemedia.
The dark gray zone covers the whole length of themiddle bar:
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• When a virtual media has just been loaded, the top bar represents the wholemedia.
The dark gray zone represents the wholemedia and covers the whole length of the
middle bar:

• When a virtual media is loaded, double-clicking on the dark gray zone toggle the
section covered by the top bar from the wholemedia length to the virtual media length
(betweenmark IN andmark OUT), and vice-versa:

The dark gray zone is reduced to represent the virtual media length and position with
regard to the wholemedia.

• If you position themouse on themiddle bar and rotate themouse wheel up or down,
you respectively increase or reduce the section of themedia, or virtual media, visible
in the top bar. Thus, the dark gray zone is enlarged or reduced:

• If you click on the dark gray zone and drag it to the left or to the right, you shift the
section of media, or virtual media, visible in the top bar to the beginning or to the end of
themedia.

Nowline, Mark IN and Mark OUT

Display

The (mark) IN point, the (mark) OUT point, and the nowline are shown in themedia bar of
the Player paneas vertical lines.

• An IN point, or mark IN point is shown as a green line on themedia bar.

• AnOUT point, or mark OUT point is shown as a red line on themedia bar.

• The nowline, representing the current position within the loaded element, is shown as
a blue line on themedia bar. To place the nowline at a given position, simply click at
the requested position on themedia bar.
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Moving Points

Tomove the position of themark IN, mark OUT or nowline, click on them with themouse
and drag them to the desired position.

Nowline Outside Media Bar

When themedia is being played, the nowlinemoves along the topmedia bar. If only a
section of themedia is visible in the top bar, the nowlinemay disappear. In this case, a red
indicator, on the right side of themedia bar will be displayed. A click on the vertical
indicator (on the right side) will re-center the top bar on the nowline.

Moving themiddle bar to the right or to the left can lead to such a situation, with the
nowline disappearing respectively to the left or to the right of the top bar.

Jog Bar
The bottom bar is the jog bar.

Dragging the speed indicator on the jog bar allows you tomove within themedia at a
variable speed:

The speed varies depending on:

• the position of the speed indicator

• the speed range covered by the jog bar. The default range is set from -200% to
+200%. This is set in XedioManager.

Audio can be heard when using the jog.
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3.3.5. Loading Media on the Player Window
You can proceed in different ways to load amedia or a virtual media on the Player:

• Drag the virtual media from the Virtual Media pane to the Player window:

or

drag themedia (or the virtual media resulted from a search) from theMedia tab to the
Player window:
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• From theMedia tab, double-click themedia to load

or

from the Virtual Media pane, double-click the virtual media to load.

At the same time, the Tabs Pane will switch to theVirtual Media Properties tab.

3.3.6. Play Media in the Additional Player
It is also possible to loadmedia or virtual media on an additional Player window. To do so,
right-click on amedia or virtual media and select Play from the contextual menu. The
media or virtual media cannot bemodified using this player but can be viewed while
another piece of media is still loaded within the Player pane.

To start or stop the playout, click within the video area of the window or press the Space
bar.

TheMedia and Jog bars at the bottom of the window can be used as in the Player pane.
See section "Media Bar and Jog Bar" on page 28.

The video and audio tools can be used as described in section "Video and Audio
Monitoring Tools" on page 25.
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4. Virtual Media Pane

4.1. Introduction

As soon as a virtual media has been created it appears in the list of the Virtual Media
pane.

To display the list of virtual media associated to amedia, select themedia in theMedia
tab of the Tabs pane.

Virtual media items are displayed in columns. Some of the details can be edited from here,
others are only for information.

Double-click the label of an unpublished virtual media to enable text entry or update in the
cell.

A virtual media can be loaded on the Player pane as explained in section "LoadingMedia
on the PlayerWindow" on page 31.

4.2. Virtual Media List Display

4.2.1. Displayed Columns
It is possible to re-arrange the columns order, and to add or remove some columns.

Right-clicking on any of the column headings displays a contextual menu. TheChoose
Displayed Columns option opens the Select Visible Columns window allowing you to
choose the columns you want to be displayed in the element list. See section "Glossary of
ColumnHeadings" on page 34 for detailed information on the column headings available.

The columnwidth and order can be adjusted using standard computer commands and
drag and drop techniques.

USER MANUAL Xedio Suite 4.50 Xedio Browse

4. VirtualMedia Pane 33



4.2.2. Show Thumbnails
TheShow Thumbnails option is available from the column headings contextual menu
This option adds thumbnails in the Thumbnail IN and Thumbnail OUT columns of the
Virtual Media pane, provided that those columns have beenmade visible.

4.2.3. Glossary of Column Headings
Column
Heading Description

Label A media or a virtual media can have a name added to the label field in the
tab area.

ClassList This is the overall group to which a created clip belongs; the structure of
the classes is set by the administrator when designing a system
installation.

Thumb In /
Thumb Out

A reference frame can be shown to visually identify the correct material.

Duration The item duration.

TC In The IN timecode of the item.

TC Out TheOUT timecode of the item.

Shooting
Date

A user defined date entry for the date themedia was originally shot.

Published Indicates if themedia has beenmade available to other users within
Xedio Suite.

Treated A media that has already been worked on (browsed) for virtual media
creation.

Creation
Date

The date and time that the item was created; this refers to when it was
entered into the database.

Description A field for a free text entry to describe themedia.

UserName The user who ingested themedia to the system.

Group The place (defined with groups) from where themedia was ingested.

System Shows the video standard of the clip.

FeedID The original identifier of the feed (given by the press agencies for
example).

External
Ref

Additional reference for themedia that would already be used (bar code of
a digitized tape for example).

Priority A rating for the item.

Ratio Shows the video ratio of the clip, for instance 16/9 or 4/3.
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4.3. Virtual Media List Contextual Menu
A contextual menu is available when you right-click on amedia item in the list, provided
that it is not in Published state:

Menu
Item Description

Published
State

Displays a sub-menu which allows to change the publish state of the virtual
media toPublished. A publishedmedia will be displayed in the database
lists of all the software and will thus be available for use.

Delete
Virtual
Media

Allows the deletion of the selected Virtual Media.

Play Opens a new Player window to allow themedia to be played. See section
"Play Media in the Additional Player" on page 32.
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5. Menu Bar
Several commands are available from theMenu Bar at the top of the Xedio Browse
window.

A logbook can be displayed by selecting the View > Logbook bar option.

This gives information about operations performed when using the Xedio Browse
application.

The versions of the installed applications are available from the Help > About option.
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+32 4 361 7000
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